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CHAPTER 1. INTRODUCTION 

1.1 What is AUSRIVAS? 

In response to the growing concern in Australia for maintaining ecological values, the National River 

Health Program (NRHP) was formed. A major component of the NRHP was the development of the 

Australian River Assessment System (AUSRIVAS) to fulfill the need for a nationally standardised 

method to assess the ecological condition of Australia's rivers. It is based on the River Invertebrate 

Prediction and Classification System (RIVPACS), which is used nationally in Britain.   

AUSRIVAS is a standardised national system for assessment of river condition that uses benthic 

macroinvertebrates and includes standardised data analysis using sets of predictive models. 

AUSRIVAS provides a site-specific, biological assessment of river condition. AUSRIVAS consists of 

mathematical models that can be tailor made for use in different aquatic habitats and for different 

times of the year. These models predict the aquatic macroinvertebrate fauna expected to occur at a 

site in the absence of environmental stress, such as pollution or habitat degradation.   

The AUSRIVAS approach offers several advantages over earlier assessment techniques and is an 

easy-to-use tool that provides easy-to-interpret biological assessment outputs. The sampling 

methods are standardised, easy to perform and require minimal equipment. Rapid turnaround of 

results is possible and the outputs from the AUSRIVAS models are tailored for a range of users 

including community groups, managers and ecologists. The outputs such as the Observed/Expected 

(O/E) scores are comparable all over Australia.  

Sampling methods are standardised by States and/or Territories and all have collected the reference 

site data used to create the predictive models. Although standardised, a degree of regionalisation is 

needed to cover the range of stream types and climatic ranges experienced Australia wide. 

AUSRIVAS models have been developed for each State/Territory, for the main habitat types that can 

be found in Australian river systems. These habitats include the edge/backwater, main channel, riffle 

and pools. The models have been constructed from single season data and from several seasons 

combined to provide more robust predictions. When a new test site is sampled, it will be compared 

to the many reference sites that were used to create the predictive model. To date, the AUSRIVAS 

predictive system has been developed primarily for lotic environments. Future research and 

development of the AUSRIVAS system is aimed at widening its scope for use in estuarine and 

wetland environments.  

1.2 What is the macroinvertebrate predictive modelling software? 

The AUSRIVAS macroinvertebrate predictive modelling software implements the predictive 

modelling system described in Section 1.1. The user enters test site taxonomic and physical/chemical 

data into the software (see Sections 3.2 and 3.3). This information is used, along with model data 

located on a central server (see Section 1.3) to produce a variety of information about the condition 

of the test site. The outputs of the software are tabular data, ordered in 'sheets'. The sheets that 

provide information that can be used to assess the condition of a test site are:  

1. Group probabilities 

2. Taxa probabilities  

3. Predicted/collected  

4. Unused bugs  

Detailed descriptions of these and other outputs from the software can be found in Chapter 5. 

http://lwa.gov.au/programs/national-river-health-program
http://lwa.gov.au/programs/national-river-health-program
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1.3 How the software uses the Internet 

The AUSRIVAS Macroinvertebrate Predictive Modelling software requires Internet access in order to 

run a model. Model data is maintained at a central site and stored on a server at this site (currently 

at the eWater University of Canberra site). When an authorised user runs AUSRIVAS, the software 

connects to this central server to access the latest model information and uses this to produce an 

assessment of the condition of a test site.  

If you do not have Internet access, you can still run the software and load previously saved data, but 

you won’t be able to access information about the models and you won’t be able to run a model. 

There are two ways of running AUSRIVAS. You can work off-line, where the program does not access 

the Internet, or you can run AUSRIVAS over the Internet.  

AUSRIVAS needs to access the Internet in order to: 

- Run a model;  

- Access information about models, such as required predictor variables and model bands.  

If you run the AUSRIVAS Macroinvertebrate Predictive Modelling Software without an Internet 

connection, you can only load and view previously saved data. You cannot run a model or access 

model information in an off-line mode.  

Further information 

For information on how to set up AUSRIVAS to run over your Internet connection, see Section 2.3. 

CHAPTER 2. GETTING STARTED 

2.1 Gaining access to the models 

To access AUSRIVAS models from the AUSRIVAS software package, you need to have a username 

and password. 

There is a charge for creating an AUSRIVAS username and password to access the models. This 

charge is calculated on a cost recovery basis and covers the costs of creating your username and 

password only. The cost is $99 (50% discount for non-profit organisations), which you will be 

invoiced for after your AUSRIVAS account is created.  

2.1.1 To get an AUSRIVAS account (currently via eWater Toolkit) 

To run the AUSRIVAS predictive modelling software each user requires an eWater Toolkit 

membership (free). If you are not already a toolkit member, please go 

to: https://toolkit.ewater.org.au/member/CreateUser.asp to create an account. 

Once you have successfully created an account you will be able to sign into the AUSRIVAS website 

https://ausrivas.ewater.org.au/ with your Toolkit username and password. 

Request access to model groups 

To run the AUSRIVAS predictive modelling software each user requires access to a model group. 

Access to models is restricted to eWater Toolkit members.  

Once you signed into the AUSRIVAS website with your Toolkit username and password go to the ‘My 

Models’ tab on the menu and under ‘My Account’ request access to the model groups that you 

https://toolkit.ewater.org.au/member/CreateUser.asp
https://ausrivas.ewater.org.au/
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require. Once your request is submitted it will be reviewed and sent to the designated AUSRIVAS 

technical team for approval. Your will also receive an invoice for payment.  

You will be notified of your access to the requested model groups once payment is received and the 

AUSRIVAS technical team has confirmed your access (usually within 2 weeks). If you need your 

AUSRIVAS account sooner than this, please make sure the technical team knows this by contacting 

them directly at ausrivas@canberra.edu.au 

Note: To approve access evidence of your AUSRIVAS training and experience (for that state) is 

required before approval can be granted. Please provide this information to accompany your model 

access request. If requesting access where you have not been trained and accredited in a particular 

State/Territory, you should provide accreditation documentation for other states and also 

demonstrate your understanding of the differences regarding sampling methods between each 

state.  

Further information 

If you need further information about obtaining AUSRIVAS software, please contact 

ausrivas@canberra.edu.au  

2.1.2 Conditions of use 

Please note that your AUSRIVAS username and password are confidential and are to be used by 

yourself only. New members of an organisation, including research staff and students, must obtain 

their own AUSRIVAS username and password.  

Why can’t I give my password to someone else to use? 

The restrictions on the transferral of AUSRIVAS accounts has come about for two reasons: 

1. AUSRIVAS Training and accreditation. At the workshop for the AUSRIVAS Training and 

Accreditation project, State and Territory representatives, along with Environment Australia 

and CRCFE representatives, decided that passwords would be issued to individual users, 

rather than to groups of users, as had previously been the case. It was also decided that 

State and Territory representatives would authorise account requests from their relevant 

State or Territory.  

2. AUSRIVAS mapping and reference site screening module. The AUSRIVAS Mapping and 

Reference Site Screening Module, due for release in 2003, makes use of 3rd party data - the 

1:250k streamline data from AUSLIG. In order to allow use of this module without all users 

needing to have an AUSLIG license for the 1:250k streamline data, we reached an agreement 

with AUSLIG, which defines several conditions. One of these conditions is that access to the 

maps produced with the streamline data is password protected, where each authorised 

individual is known and has a non-transferable password.  

2.1.3 I don't have an AUSRIVAS account. Can I still use the software? 

An AUSRIVAS username and password restricts access to AUSRIVAS models only. You cannot run 

data through an AUSRIVAS model if you don’t have an AUSRIVAS account. However, you can make 

use of the software and utilise some of its functionality, as described below: 

1. Download the AUSRIVAS software. 

2. Run the AUSRIVAS Macroinvertebrate Predictive Modelling software and:  

- Load and view previously saved data;  

- Find out which models are available;  

mailto:ausrivas@canberra.edu.au
mailto:ausrivas@canberra.edu.au
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- Find out which predictor variables are used by a model;  

- Edit, print and save loaded data.  

3. Access the AUSRIVAS manuals.  

4. Request help. See Chapter 9, or email ausrivas@canberra.edu.au. 

2.2 Obtaining the software  

The AUSRIVAS Macroinvertebrate Predictive Modelling software is available via download from the 

AUSRIVAS website. Go to: https://ausrivas.ewater.org.au/index.php/get-the-predictive-modelling-

software    

For information on how to use the AUSRIVAS program, refer to the AUSRIVAS Predictive Modelling 

manual at: https://ausrivas.ewater.org.au/index.php/manuals-a-datasheets  

2.3 Configuring the software for Internet access 

2.3.1 Running AUSRIVAS with or without Internet access. 

There are two ways of running AUSRIVAS (called ‘run options’). You can work off-line, where the 

program does not access the Internet, or you can run AUSRIVAS over the Internet (in on-line mode).  

Running AUSRIVAS over the Internet (On-line mode). 

AUSRIVAS needs to access the Internet in order to  

- Run a model;  

- Access information about models, such as required predictor variables and model bands.  

You can access the Internet in two ways, either directly or through a proxy server. To find out which 

Internet access method you need to use, contact your local systems administrator. To access the 

Internet through a proxy server, you will need two pieces of information about your proxy server:  

1. The name of your proxy server, and 

2. The port your proxy server runs on.  

If you access the Internet through a proxy server, you will need to know if your proxy server requires 

authentication. You can get this information from your systems administrator. If your proxy server 

does require authentication, you will need to know:  

1. Your Internet username, and 

2. Your Internet password.  

Running AUSRIVAS off-line. 

Alternately, you can choose to work off-line. In off-line mode, you can load and view previously 

saved data. You cannot run a model or access model information in off-line mode. 

2.3.2 Selecting your run options 

When you run the AUSRIVAS Predictive Modelling Software (see Section 3.1), a dialog box for setting 

up the software for Internet access will be shown:  

https://ausrivas.ewater.org.au/index.php/get-the-predictive-modelling-software
https://ausrivas.ewater.org.au/index.php/get-the-predictive-modelling-software
https://ausrivas.ewater.org.au/index.php/manuals-a-datasheets
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To work off-line:  

Click on the 'Work Offline' button at the bottom of the dialog.  

To access the Internet directly:  

Select the 'No proxy server' option and click on 'OK'.  

To access the Internet through a proxy server:  

Click on the 'Proxy server' option at the top of the dialog box. You now need to fill in your proxy 

server settings, as described in the next section.  

2.3.3 Proxy server settings 

If you want to run AUSRIVAS over the Internet through a proxy server, you need to provide 

AUSRIVAS with information about your proxy server. AUSRIVAS needs to know:  

- The name of your proxy server, and 

- The port your proxy server runs on.  

The name of your proxy server is made up of a machine name followed by your Internet domain. For 

example, the proxy server at the University of Canberra is called 

proxyhost.canberra.edu.au.  

The port number your proxy server runs on is an integer. Many proxy servers run on port 80.  

There are two ways you can provide AUSRIVAS with this information: 

1. If you have previously set up your proxy server in Internet Explorer, you can select the 

'Internet Explorer settings' option, and AUSRIVAS will get your proxy server settings from 

your saved Internet Explorer settings.  
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2. Alternately, you can enter the proxy name and port information yourself. To do this, select 

the ‘Custom settings’ option, and then type in your proxy server name in the ‘Proxy host’ 

text box, and your proxy server port number in the ‘Proxy Port’ text box.   

 

If you do not need to provide proxy authentication details, you can now select 'OK' to run AUSRIVAS.  

Note: If you haven’t selected ‘Custom settings’, the proxy host and proxy port text boxes will be 

disabled. Your local Systems Administrator can tell you your proxy server name and port number. 

2.3.4 Proxy authentication 

If your proxy server requires authentication (i.e. you enter a username/password to access the 

Internet), you will need to provide your proxy server username and password to AUSRIVAS.  

To do this, check the 'Proxy authentication' check box, and type your proxy username and proxy 

password into the 'Proxy username' and 'Proxy password' text boxes.  
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When you have provided your Proxy Authentication details you can select 'OK' to run AUSRIVAS.  

Note: If you haven’t selected ‘Custom settings’, the proxy host and proxy port text boxes will be 

disabled. If you do not know what your proxy username and password are, or if you do not know if 

you need one, ask your local Systems Administrator.  

 

2.3.5 Saving settings 
When you click on 'OK', AUSRIVAS will save all of your proxy settings, except your proxy password, 

for use the next time you run AUSRIVAS.  

2.3.6 Altering your Internet settings 
You can change your Internet settings while you are running AUSRIVAS, by opening the 'Internet 

Settings' dialog from the 'Options/Proxy server settings ...' menu. You will also always be shown the 

'Internet Settings' dialog each time you run the program in case you need to change your options.  

Note: Once you have selected to run in either offline or online mode, you cannot change this while 

you are running the program. To go from offline to online mode or vice versa, you will need to quit 

the AUSRIVAS program and restart.  

CHAPTER 3. USING THE AUSRIVAS SOFTWARE 

3.1 Starting the AUSRIVAS program   

By double-clicking on the AUSRIVAS icon, (either in Explorer or on the Desktop if you have set up a 

shortcut) the AUSRIVAS program will open. It has a series of labelled overlying sheets with menus 

and a toolbar across the top of the page and a status indicator at the base. 

The first sheet is for the entry of invertebrate data, the second sheet for entry of habitat data. The 

remaining sheets will contain various outputs from the model once it has been run. The complete list 

of data sheets is: 
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1. ‘Bug Data’ This is where you enter your invertebrate data.  

2. ‘Phys/Chem Data’ - This is where you enter your predictor variables. 

3. ‘Group Probabilities’ - Shows group probabilities after a model has been run.  

4. ‘Taxon Probabilities’ - Shows taxon probabilities after a model has been run.  

5. ‘Predicted/Collected’ - Shows output statistics after a model has been run.  

6. ‘Unused Bugs’ - The taxa that were not used when the model was run are moved to this 

sheet.  

The toolbar includes some standard Microsoft Windows menu items along with a few new ones for 

importing and exporting text format data. 

 

3.2 Preparing data 

AUSRIVAS requires the use of specific codes for the macroinvertebrate taxa and habitat variables. 

Family level taxonomic codes for macroinvertebrate taxa are available from the AUSRIVAS website: 

https://ausrivas.ewater.org.au/index.php/taxonomy, listed in alphabetical order by both codes and 

family name. Macroinvertebrate data may be entered as either totals or as presence/absence data, 

however, AUSRIVAS will convert all macroinvertebrate data to presence absence form for analysis 

when a model is run. 

Note: To combine data for entry into a combined season model the habitat data should be averaged 

and the macroinvertebrate data summed for the same site sampled in both spring and autumn. 

Which predictor variables do I need? 

The predictor variables required may be different for each model. A list of the habitat variable codes 

required for each model can be obtained through the AUSRIVAS predictive modelling software, as 

described below. 

Note: You must be running in online mode to access the list of habitat variables. 

Note: You do not need to have a password to view the list of habitat variables. 

Viewing required predictor variables 

To open the list of required variables, first select the model you are interested in by following these 

steps. 

1. Open the 'Select a model' dialog box by clicking on 'Required variables' from the 'Model' menu. 

https://ausrivas.ewater.org.au/index.php/taxonomy
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2. Double-click on the region for the model you are interested in. This will open up a list of seasons 

for that model. 

3. Double-click on the season you want. A list of habitats will now be visible. 

4. Finish the selection of your model by either double-clicking on the habitat, or selecting the habitat 

with a single mouse click, and hitting the 'Select' button. 

 

A 'Required variables' dialog box will then open, which lists the model name, the variable code and 

a description of the required predictor variables for that model. 
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3.2.1 Further information 

For more information on using the ‘Required Variables’ dialog box, see Section 3.8. 

3.3 Entering data 

Data can be entered into AUSRIVAS either by importing it from another location or entering it 

directly.  

3.3.1 Importing data from another application 

Invertebrate and habitat data files that are to be imported must be delimited text files. Any text 

delimiter can be used, but the most common are:  

- Comma delimited (.csv files) 

- Space and/or tab delimited (e.g. you can save an MS Excel spreadsheet as a *.txt file). 

Importing invertebrate data 

AUSRIVAS will automatically open on the 'Bug Data' sheet. 
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To import your macroinvertebrate data file, open the 'File' menu and select 'Import' or click on the 

import button on the toolbar . An options box listing possible file formats and attributes will 

appear. If the first data item in each of the rows in your macroinvertebrate data file is the site code, 

select the 'with Row Headers' option, and the site codes will be used as row headings in AUSRIVAS. 

The same applies to column headers. If the first row in your macroinvertebrate data file 

contains taxa codes, select the 'with Column Headers' options and the taxa codes will be imported 

into your AUSRIVAS spreadsheet. 

 

Now you need to let AUSRIVAS know about the format of your file. As discussed above, your file 

must be in a text-delimited format, so you just need to specify the delimiter used in your file. In the 

diagram above, the delimiter is specified as ‘Space & Tab Delimiting’. This means that the gaps 

between each data item in a row of data are made up of spaces and/or tabs.  

You can separate your data with other delimiters if you wish. To specify that your data collection is a 

.csv file (separated with commas) the option 'Other' is selected for delimiter type, and the delimiter 

itself (a comma) is entered into the text box beside the 'Other' option. 

When you have specified the type of delimiter in the text file you wish to import, click 'OK'. A 

directory box will open allowing you to browse and select the file to be imported. 

 

When you have selected your file, click 'Open', and your data will appear on the ‘Bug Data’ sheet 

with taxa listed across the top, and site codes listed down the side (as shown below). 

http://ausrivas.ewater.com.au/index.php/taxonomy
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Importing Phys/Chem data 

To import the file containing your physical and chemical data (predictor variables), click on the tab 

labelled 'Phys/Chem Data' to make this sheet active. 

 

The procedure is now the same as used for the macroinvertebrate data. Once the data are entered, 

both spreadsheets should be trimmed to ensure no blank rows or columns, using the ‘delete blank 

rows and columns’ button on the toolbar .  

Note: The 'trimming' procedure will also indicate any extraneous data in rows and columns, which 

will require deletion. 

3.3.2 Entering data directly into AUSRIVAS 

To enter the invertebrate codes and site codes into the 'Bug Data' sheet, double click on the desired 

header box. A cursor will appear allowing the headers to be entered. To enter the data simply click 

on the desired cell. If at a later date you wish to modify an entry, a single click will allow replacing an 

entry while a double click will allow the entry to be modified. Once the invertebrate data has been 

entered click on the tab at the bottom of the screen for the ‘Phys/Chem Data’ sheet. A blank sheet 

will open to enter the physical and chemical variables that are required to run the model. Again, 

once the data is entered, both spreadsheets should be trimmed to ensure no blank rows or columns, 

using the ‘delete blank rows and columns’ button on the toolbar . 

http://ausrivas.canberra.edu.au/Bioassessment/Macroinvertebrates/taxonomy.html
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Note: Before proceeding to run the AUSRIVAS model you should save the AUSRIVAS file with your 

input data. If errors are encountered from this point on you can easily re-open the saved file and 

correct any errors, which may save you the time of importing the data again.  

3.3.3 Checking your input data for errors 

Invertebrate data 

It is important that there are no blank cells, as a site assessment cannot be produced for sites with 

blank cells in the invertebrate data. AUSRIVAS will highlight any cells with blank data in blue (as 

shown below). 

 

AUSRIVAS will also warn you when it does not recognise a taxon code. The causes of this will be 

either: 

- The taxon code is incorrect. In this case check the list of valid invertebrate codes.  

Note: taxa codes and habitat variable names are case sensitive.  

- The taxon is not known to AUSRIVAS. It is not necessary to delete the column if the taxon 

code is correct but simply not known to AUSRIVAS. Instead you are advised to retain the 

column and AUSRIVAS will move it to the 'Unused Bugs' output sheet when running the 

model. 

A warning message and orange highlight will occur when a taxon has an incorrect code and/or the 

models do not cover that taxon (as shown below). 

 

Predictor variables 

As for the invertebrate data, it is important that there are no blank cells, as a site assessment cannot 

be produced for sites with blank cells in the predictor variable data. 

If AUSRIVAS does not recognise a predictor variable code, it will highlight the variable code as an 

error. Note that this is different from the Invertebrate data, where only a warning is given and the 

model can still be run. If AUSRIVAS does not recognise a predictor variable code it cannot run the 

model. 

AUSRIVAS may not recognise your predictor variable code if you have spelled the code incorrectly, or 

if the variable itself is not known to AUSRIVAS. When a predictor variable has an incorrect code or is 

not known by AUSRIVAS an error message and red highlight will occur (as shown below). In this 

http://ausrivas.canberra.edu.au/Bioassessment/Macroinvertebrates/taxonomy.html
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example, the variable ‘LATITUDE’ has been incorrectly called ‘LAT’ and the blue highlighting indicates 

a blank cell. 

 

If you have an unknown predictor variable code in your data, it must be removed or rectified before 

running a model. 

3.3.4 Removing/editing data 

If you want to change your data because of an error or warning, you can do so by either: 

- Editing and re-importing the original data file, or 

- Entering the correct values directly into the ‘Bug Data’ or ‘Phys/Chem Data’ sheets.  

Deleting a data column 

To delete a data column, click in the header box of that column and the column will be highlighted. 

Next click on the ‘Edit’ menu and select ‘Remove Column’ and the selected column will be deleted.  

Care should be taken when removing taxa that any taxa required by the model are not deleted. If 

you do omit taxa that are required by the model, a dialog box that appears after running a model 

will identify any missing taxa and habitat variables. 

3.4 Setting options 

3.4.1 Taxa probability 

The O/E x score, where x is a probability between 0 and 100, is derived using only taxa that were 

calculated to have a probability of x% or greater of occurring at a test site. Thus an O/E 0 score 

considers all predicted taxa regardless of their probability of occurrence, while an O/E 99 score 

considers only taxa that had a 100% chance of occurring at a test site. 

The use of a probability cut-off enables users to exclude rare taxa and thus affect the precision and 

sensitivity of an AUSRIVAS model. The default cut-off is 50%. This be modified to set the cut-off in a 

range from anywhere between 0 and 100, allowing you to decide on the level of precision and 

sensitivity you want from your model.  

To set the probability cut-off, go to ‘Set Taxa Probability’ in the ‘Options’ menu (as shown below).  
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This will open the ‘Set taxa probability’ dialog box (as shown below). To change the default 

probability cut-off, type the probability (an integer between 0 and 100) into the edit box and click 

‘OK’ to save your changes, or ‘Cancel’ to retain previous settings. 

 

To restore the default probability, click on the ‘Restore default probability’ button. 

3.5 Choosing a model 

3.5.1 Which model do I use? 

For each State/Territory a minimum choice of 6 models is available; 2 habitats and 2 seasons, plus a 

combined seasons model for each habitat. Where and how the test site data were collected will 

determine the model required to provide a site assessment. Test data can only be run though a 

model created for the same state, territory or region your data has been collected in, and it must 

have been collected using the same methods (please refer to the relevant sampling and processing 

manual available at: https://ausrivas.ewater.org.au/index.php/manuals-a-datasheets, as this will 

affect the results obtained.  

For example, a test site sampled in the ACT according to territory protocols could not be assessed 

using a NSW model, as macroinvertebrate sample processing for ACT models is done in a laboratory, 

whereas NSW models use a field live-pick protocol. Habitat predictor variables are also likely to be 

measured differently in different states and territories, which will also affect the results obtained. 

Similarly, the habitat sampled will affect the biota collected, therefore a riffle model can only be 

used to assess data collected in a riffle habitat in the same region, sampled in the same way as the 

data used to create the model.  

When selecting a season, use the seasonal model closest to the season your test site was sampled in 

(check the appropriate State/Territory sampling manual for definition of sampling seasons). 

However, if both an autumn and spring sample of a test site are available, it is preferable to combine 

the data and choose the combined Autumn+Spring season model, ensuring the taxa list for the test 

site is maximised. 

3.5.2 Selecting and running a model in the program 

To select and run a model once data entry is complete, click on the ‘Run Model’ option under the 

‘Model’ menu or click on the ‘run model’ button on the toolbar  . 

https://ausrivas.ewater.org.au/index.php/manuals-a-datasheets
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A 'wizard' will now appear. This lets you (in order): 

1. Enter your AUSRIVAS username and password, 

2. Select the region your data were sampled in, 

3. Select the season your data were sampled in, and 

4. Select the habitat your data were sampled from. 

To run a model using this wizard, first enter your AUSRIVAS username and password and click ‘Next’. 

 

Then select the State/Territory or region your test sites were sampled in and click ‘Next’. 
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Now select the season(s) your test sites were sampled in and click ‘Next’. 

 

Finally, select the habitat sampled at your test sites and click ‘Finish’. AUSRIVAS is now running your 

chosen model.  

 

Note: If you do not have an AUSRIVAS username and password available via the eWater Toolkit, 

please contact ausrivas@canberra.edu.au for assistance.   

3.6 AUSRIVAS is running 

The first step AUSRIVAS will perform is validating your data. Typical errors encountered at this stage 

may include missing data, incorrect invertebrate codes, misspelled habitat variable names, missing 

some required invertebrate taxon codes and missing predictor variables. If AUSRIVAS detects any 

errors in the variable names or in the data, the program will stop and the list of detected errors will 

appear. A more detailed explanation of some typical errors and the resulting windows follows.  

3.6.1 Errors/warnings in input data 

Warning - missing taxa 

A window similar to the following will appear if your bug data set does not contain all the taxa codes 

required by a particular model. Your data set may not contain certain taxa because they were not 

collected, in this case AUSRIVAS will add them (with zero values) to your data set before running the 

model, and will inform you in a 'warning' dialog (as shown below).  

mailto:ausrivas@canberra.edu.au
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Note: While you have the above window in view, print out the list of missing taxa and check that 

they are indeed missing from your dataset, not simply coded incorrectly. Note that coding problems 

may arise where taxonomic name changes have occurred since construction of the models. For 

example, many Odonata families have now been subdivided into several families since constructing 

some models; in cases like this the previous family name will need to be used. So be on the watch 

and check for this type of error. 

Error - missing predictor variable 

If a predictor variable required by a model is missing, the model cannot run and you will get an error 

dialog similar to that shown below. A predictor variable can be deemed 'missing' if you have omitted it 

from your data set, or if you have spelled the variable name incorrectly. Changing the (correct) spelling 

of the ‘LATITUDE’ variable to ‘LAT’ generated the example below.  

A list of the required predictor variables for each model can be obtained via the 'Required Variables' 

option in the 'Model' menu. More information on this is given in Section 3.3. 
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Error - site mismatch 

If the site codes listed in the Bug Data file do not match exactly those in the Phys/Chem data file a 

window similar to the following will appear explaining the error.  

 

Error - blank data cells 

It is important that there are no blank cells, as a site assessment cannot be produced for sites with 

blank cells in either the macroinvertebrate data or the predictor variables. AUSRIVAS highlights any 

cells with blank data in the input data sheets in blue. If data is not inserted in these blank cells 

before a model is run, you will get an error as shown below. The error description tells you in which 

sheet (‘Bug Data’) and which row (Site 012) and column (MM999999) the blank/invalid cell occurs.  
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3.6.2 Is your data within the experience of the model? 

Once the errors in the input data have been corrected the model can be restarted. If your data then 

pass the validation checks AUSRIVAS will proceed to the predictive calculations.  

AUSRIVAS will now check if the test data are within the experience of the model you have chosen. 

That is, are there suitable reference sites with which your test sites can be compared? Your test sites 

may appear to be outside the experience of the model if;  

- The wrong model for the season of sampling was chosen (or two seasonal data sets were 

combined incorrectly for a combined season model, which will result in incorrect values for 

the predictor variables), 

- Incorrect values (e.g. incorrect units of measurement used) have been entered for the 

predictor variables or, 

- It may be that the model has no suitable reference sites with which to compare the test 

data, AUSRIVAS will provide a warning (as shown below).  

 

In the example above, Site 011a is highlighted red and the text beside the site code reads ‘This site is 

outside the experience of the model (Chi2 0.001)’ and no output is provided for that site. Site 012 

and Site 014 are highlighted orange and when the curser is placed over the site code a text box 

appears with the words ‘Warning: This site is nearly outside the experience of the model (Chi2 0.01)’. 

For these sites an output is provided but interpretation should proceed with caution because the 

site data is nearing the limitations of the model. Chi2 0.001 and 0.001 relate to the Chi squared test 

performed on the data. For further information on the Chi squared test, refer to Chapter 7.  

Note: If your site is unexpectedly outside the experience of the model, check the Phys/Chem input 

data for errors, such as: 

- Typographic errors, 

- Incorrect units of measurement used for predictor variables, 

- Incorrect format used for LATITUDE or LONGITUDE predictor variables. 

Note: Each time a model is run the existing data in the spreadsheet should be cleared to ensure 

that this data does not remain when new data are run through the model. There are several ways to 

clear data:  
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1. Select the entire spreadsheet by clicking in the top left corner of the spreadsheet and then 

select ‘Clear’ from the ‘Edit’ menu. 

2. Click on the new icon  in the toolbar.  

3. Select ‘New’ from the ‘File’ menu.  

3.7 Saving AUSRIVAS outputs 

3.7.1 Exporting data sheets 

Each of the AUSRIVAS output sheets can be exported separately as a text file by selecting the desired 

sheet and using the ‘Export’ function in the ‘File’ menu or the ‘export’ button on the toolbar . A 

box will appear listing format options for the exported text file. Select the desired option and click 

‘OK’. A box enabling you to name the text file and save it to a specified directory will then appear. 

Name the file, select a directory and click ‘Save’ to complete exporting. 

When you export a datasheet, you get a delimited text file only. All non-text information in the data 

sheets such as colours and pop-up information will be lost. You can import your exported files into 

other programs, such as spreadsheets, that recognise delimited text formats. 

3.7.2 Saving a document 

The whole document (all of the data and output sheets) can also be saved as an AUSRIVAS file, 

which has the file extension ‘.AUS’. In this case the file is saved in a binary, rather than a text, format 

and it contains all of the information you see when you run the software. A file saved in this format 

can only be opened again using the AUSRIVAS software. To save an .AUS file either use the 'Save As' 

option under the 'File' menu or click on the ‘save’ button in the toolbar . 

This file can then be viewed at a later date by choosing 'Open' from the 'File' menu or clicking on the 

‘open’ button in the toolbar .  

3.8. Working with dialogs 

3.8.1 Model select dialog 

When you select the menu items to view either the model ‘Required Variables’, or ‘Bandwidths’ 

you will firstly be presented with the 'Model Select' dialog box to choose the model you want 

information on (as shown below).  
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Follow the steps below to select a model. 

1. Double-click on the region for the model you are interested in. This will open up a list of seasons 

for that model. 

2. Double-click on the season you want. A list of habitats will now be visible. 

3. Finish the selection of your model by either double-clicking on the habitat, or selecting the habitat 

with a single mouse click, and hitting the 'Select' button. 

 

3.8.2 Required variables dialog 

The 'Required Variables' dialog box can be opened from the 'Model' menu. When you have selected 

the model you are interested in, the 'Required variables' dialog box will open for the model you 

have chosen (see below). This dialog box lists the: 

- Model name, 

- Variable codes for that models’ required variables, and  

- A description of the variables. 
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Viewing data 

The 'Required variables' dialog box is scrollable and resizable, so you can either scroll to view items 

that do not fit in the dialog, or you can make the dialog box bigger.  

Printing 

You can print data shown in the 'Required variables' dialog box. Select 'Print' from the 'File' menu: 

 

A standard format 'Print' dialog box will open, as shown below, which allows you to select your 

printer, set printer properties, and print to either a printer or to file. 

 

Page setup 

You can control various aspects of how the required variables data is printed to the page using the 

'Page Setup' dialog box (as shown below). You will usually want to print column headings but omit 

row headings (as these are blank in the dialog) and may want to set margins and choose whether to 

draw grid-lines or not.  
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Note: To save your 'Page Setup' settings, so that they are used by default whenever you run 

AUSRIVAS, tick the 'Save settings to profile' box. 

Header and Footer setup 

You can also control the information that is displayed in the header and footer of your output, by 

using the 'Header / footer' dialog, available from the 'File' menu (pictured below). 

The AUSRIVAS program will provide you with a default header and footer, so you only need to 

change settings if you want to alter the default. The settings that AUSRIVAS provides in the header 

are program name and model name, as shown in the dialog pictured below. The footer contains the 

date and the page number in the 'Page n of N' format. 

 

A sample printed output from the 'Required Variables' dialog is shown below. 
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Saving/exporting 

You cannot save the information in the 'Required Variables' dialog directly from the dialog. You can 

however copy and paste the data into another application, such as a spreadsheet, where it can then 

be saved or exported into another format.  

Note: To select all the cells in the dialog box, click on the top left-hand cell (as shown below).  
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3.8.3 Model bands dialog 

The 'Model Bands' dialog box can be opened from the 'Model/Bandwidth' menu. When you have 

selected the model you are interested in, the 'Model bands' dialog box will open for the model you 

have chosen. This dialog lists the: 

- Model name, 

- Band label, 

- Band upper limit, 

- Band name, and  

- Band description. 

 

Viewing data 

The 'Model Bands' dialog box is scrollable and resizable, so you can either scroll to view items that 

do not fit in the dialog, or you can make the dialog bigger.  

Printing 

You can print data shown in the 'Model Bands' dialogs, using the same method for the 'Required 

Variables' dialog box, described above. 
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Saving/exporting 

The method used for saving and exporting is the same as for the 'Required variables' dialog box, 

described above. 

CHAPTER 4. AUSRIVAS OUTPUTS 

4.1 Introduction 

The AUSRIVAS predictive system produces a variety of information about the condition of a test site. 

Not all the output produced will be of interest to all users because some output may be too 

technical or have little relevance for the intended level of reporting. For this reason, the AUSRIVAS 

output is structured so that users can extract only the level of information required. First, the 

probability of group membership for your test sites will be calculated. Next, the individual taxon 

probabilities of occurrence at each test site will be calculated. These results are then used to 

produce the observed to expected taxa scores and also observed to expected scores for the SIGNAL 

index. The outputs of these steps are presented on separate sheets that are opened by clicking the 

name tab at the bottom of each sheet. 

 

AUSRIVAS may also modify your input data if necessary. 

Each of these datasheets is explained further in the following sections. 

4.2 Input data sheets 

4.2.1 Invertebrate data sheet 

Missing taxa added 

After running the model, you may see on the bug data sheet that the invertebrate data has been 

modified where necessary to contain all taxa codes required by the model. These added taxa all have 

a value of 0.0 indicating absence of the taxa. The screen shots below show the ‘Bug Data’ datasheet 

before running the model, and then after running the model where missing taxa such as KG029999 

have been added. 
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Unused taxa moved to 'Unused Bugs' datasheet 

After the model has run, any taxa in your bug data file that were not required by the model have 

now been moved to the ‘Unused Bugs’ datasheet.  

Note: these taxa will no longer exist in the ‘Bug Data’ datasheet. 

 

 

Data ordered 

After you have run a model, your macroinvertebrate data will be ordered alphabetically by taxon 

names. An example below (in Section 5.2.2) shows the ‘Phys/Chem’ datasheet before and after a 

model has been run. 

Presence/absence highlighting 

You will see on the ‘Bug Data’ datasheet that all macroinvertebrate data are colour coded, with 

presences highlighted in green and absences highlighted in white. This highlighting is actually done 

when you enter data rather than after the model is run but is included here for completeness. 
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4.2.2 Phys/chem data sheet 

Data ordered 

After you have run a model, your ‘Phys/Chem Data’ will be ordered alphabetically by variable name. 

‘Phys/Chem Data’ are also ordered, and the examples below show the ‘Phys/Chem Data’ datasheet 

before and after a model has been run. 
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4.2.3 Presence/absence highlighting 

The ‘Phys/Chem Data’ also highlighted to indicate presence/absence. Zero values are highlighted in 

white, while non-zero values are shown as green.  

 

4.3 Group probabilities 

The first AUSRIVAS output sheet, labelled , lists the probability of your test 

site belonging to each of the reference site classification groups. This output is useful for 

determining to which group of reference sites your test site is most similar in physical and chemical 

character. 

A probability of group membership of ≥0.5 is highlighted in green, with the rest of the data 

(probability of group membership <0.5) is highlighted in white.  

 

4.4 Taxa probabilities 

The  output sheet lists the probability of each taxon being found at a tested 

site.  

In the following section, x denotes the user set probability (a value between 0 and 100), or the 

default probability of 50%, if the user has not defined one. 

Taxa that were present (collected) at the test site are flagged (») and those with >x probability of 

occurrence are highlighted in light green. Taxa that were predicted with >x probability of occurrence 

but not collected are highlighted in dark green. Other taxa that were not collected at a site are 

shown in white on the AUSRIVAS screen.  
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This output can be used to determine what taxa you would expect to find at the test site and 

whether they were actually collected. A taxon with a 0.12 probability of occurrence that was not 

collected would not be cause for concern because it would rarely be found, even if the site were 

equivalent to reference. However, if a taxon with a 0.95 probability of occurrence was not collected 

it is reasonable to assume that some impact may have caused its absence.  

The SIGNAL grades for these families are also provided at the end of the spreadsheet to give a 

general indication of the sensitivity of each of the families to pollution. Biological information about 

that taxon may then indicate the type of impact the test site could be experiencing, providing a focus 

for further investigation. The signal grades are highlighted in blue. 

Taxon names are also provided on this data sheet. They are highlighted in pink. 

 

Note: The orange highlighting of sites 012 and 014 in this example indicate that these sites are 

‘nearly outside the experience of the model’. More information on this can be found in Section 

3.6.3 and Chapter 7. 

4.5 Predicted/collected 

The ‘Predicted/Collected’ output sheet provides an assessment of biological condition of a test site. 

The indices produced here are described in the following sections.  

4.5.1 Predicted, expected and observed taxa 

The first four columns of the ‘Predicted/Collected’ output sheet give information on the predicted, 

expected and observed numbers of taxa.  

NTEx  

The Number of inverTebrate families Expected with greater than a x% probability of occurrence, 

NTEx, is the sum of the probabilities of all the families predicted with greater than a x% chance of 

occurrence.  

NTPx  

NTPx is a count of the Number of inverTebrate families Predicted with greater than a x% probability 

of occurrence . 

NTCx  

The inverTebrate families that were predicted above the threshold probability of x% and which were 

also Collected at the test site are counted to form the observed (collected) value, NTCx.  
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OEx  

The Observed to Expected ratio, OEx, is the ratio of the number of invertebrate families observed at 

a site (NTCx) to the number of families expected (NTEx) at that site. OEx provides a measure of 

biological impairment at the test site.  

The output of these four indices is shown below for an x value of 50%. 

 

Note: See Section 0 for information on how to set the value of x. 

4.5.2 Predicted, expected and observed signal 

In addition to calculating the expected number of taxa at a test site, AUSRIVAS also calculates the 

SIGNAL scores for a site. Calculation of the SIGNAL scores uses SIGNAL grades, an assigned value 

given to each invertebrate family that indicates their sensitivity to pollution. Columns 5 to 10 in the 

‘Predicted/Collected’ output sheet contain the calculated signal scores, each of which is explained 

below.  

ExSignal  

ExSignal is the expected signal score for taxa that have a probability of occurrence of greater than or 

equal to x%. It is calculated by weighting the probability of occurrence of each predicted taxa (those 

taxa that have a probability of occurrence of greater than or equal to x%) by the taxon's SIGNAL 

Grade, summing these and then dividing the total by the sum of the (unweighted) probabilities of 

occurrence.  
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OxSignal is the observed signal score for taxa that have a probability of occurrence of greater than or 

equal to x%. It is calculated by averaging the SIGNAL Grade's for all observed taxa with P(Taxa) 

≥x/100.  
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The observed to expected SIGNAL ratio, OExSignal, is the ratio of ExSignal to OxSignal.  

E0Signal  

E0Signal is calculated the same way as ExSignal, except all taxa that have a probability of occurrence 

of greater than 0% are included in the calculation.  
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O0Signal is the observed signal score for taxa that have a probability of occurrence (P(Taxa)) of 

greater than 0%. It is calculated by averaging the SIGNAL Grade's for all observed taxa. O0Signal is 

equivalent to the ‘raw’ SIGNAL score (Chessman, 1995). 
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The observed to expected SIGNAL ratio, OE0Signal, is the ratio of E0Signal to O0Signal.  
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The calculated SIGNAL Scores are shown in the screen shot below, for a value of x = 50.  

 

 

http://ausrivas.canberra.edu.au/Bioassessment/Macroinvertebrates/Man/Pred/App/references.html
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4.5.3 The banding scheme 

For each model the O/E taxa ratios are divided into bands representing different levels of 

impairment. Band X represents a richer invertebrate community than reference, band A is 

considered equivalent to reference; band B represents sites below reference condition; band C 

represents sites well below reference condition; and band D represents impoverished sites. The 

band for each site is listed in the last column on the ‘Predicted/Collected’ output sheet, as shown in 

the screenshot above.  

4.5.4 Further information 

For further explanation of how indices and bands are calculated, refer to Chapter 3 in the AUSRIVAS 

Predictive Modelling Manual. 

4.6 EPT Predicted/collected 

The EPT predicted/collected data sheet provides an assessment of biological condition of a test site, 

using only EPT taxa. The indices produced here are described in the following sections.  

4.6.1 EPT Predicted, expected and observed taxa 

The three columns of the ‘EPT Predicted/Collected’ datasheet give information on the predicted, 

expected and observed numbers of EPT taxa.  

OE0EPT is calculated as for OE0 with the restriction that the only taxa considered are EPT taxa. 

Count 

Count is the number of different EPT taxa sampled. All collected taxa are included in this count, 

regardless of whether they are included in the model. 

OExEPT 

The Observed to Expected ratio, OExEPT, is the ratio of the number of EPT invertebrate families 

observed at a site to the number of EPT families expected at that site. The index is derived using only 

taxa that were calculated to have a probability of x% or greater of occurring at a test site. OExEPT is 

calculated as for OEx (see Section 0) with the restriction that the only taxa considered are EPT taxa. 

OE0EPT  

The Observed to Expected ratio, OE0EPT, is the ratio of the number of EPT invertebrate families 

observed at a site to the number of EPT families expected at that site. The index is derived using only 

taxa that were calculated to have a probability of 0% or greater of occurring at a test site. OE0EPT is 

calculated as for OEx (see Section 0) with the restrictions that the only taxa considered are EPT taxa, 

and that all taxa predicted to occur are included in the calculations. 

The output of these three indices is shown below for an x value of 65%: 
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Note: See Section 0 for information on how to set the value of x. 

4.7 Unused taxa 

The last data sheet in AUSRIVAS, , contains the macroinvertebrate families that 

were present and collected at the site but not used by the model as seen below. These taxa are 

generally rarer families that cannot be incorporated into the analysis. However, their presence may 

provide further information for interpretation of the type of impact or the severity of biological 

impairment at the test site. 

 

Note: Always check that the taxon codes listed in the ‘Unused Bugs’ sheet are spelled correctly. If 

the taxon codes are incorrect, your data will have been unintentionally omitted.  

Note: The data shown in the ‘Unused Bugs’ sheet has been moved here from the input datasheet 

‘Bug Data’, so if you export the ‘Bug Data’ sheet after running a model, it will not include the 

macroinvertebrates listed in the ‘Unused Bugs’ sheet in it.  

4.8 Model information 

Along with the output data sheets produced by AUSRIVAS, you can also obtain information about 

the models. The information available is: 

- Required predictor variables for each model, and  

- O/E bands for each model. 
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Both sets of information can be obtained from the 'Model' menu. Select 'Required Variables ...' to 

view lists of predictor variables, or 'Bandwidth ...' to view O/E-taxa bands as seen below: 

 

4.8.1 Required predictor variables 

Information on how to view and use the ‘Required Variables’ dialog can be found in Section 3.2 and 

also in Section 3.8. 

4.8.2 O/E bands 

Information on how to use the O/E Bands dialog is given in Section 3.8.3 

CHAPTER 5. SAVING AUSRIVAS DATA  

5.1 XML output 

Users can export AUSRIVAS inputs and outputs in XML format. Both inputs and outputs are saved to 

the same file. To export to XML, open the ‘File’ menu, and select ‘Export XML’ (as shown below). 
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When the user clicks on ‘Export XML’ in the ‘File’ menu, a dialog box will open to allow the user to 

select or input a name for the XML file (as shown below). 

 

CHAPTER 6. TROUBLESHOOTING GUIDE 

6.1 Internet access problems 

6.1.1 Cannot connect to AUSRIVAS server 

Symptoms 

When attempting to run AUSRIVAS v3.0 or below, an error message similar to one of the following is 

generated:  

- Unable to create empty document  

- AUSRIVAS error: cannot connect to the AUSRIVAS server  

Description of problem 

Incorrect Proxy Settings 

Your proxy settings may not be correct. When the AUSRIVAS program starts, it attempts to connect 

to the AUSRIVAS server. If this attempt fails, and you have selected to work in online mode you may 

get an error similar to the above.  

Network down 

Part of the network at your site, or at the University of Canberra, where the AUSRIVAS data server is 

located, may be temporarily down.  

Solution 

Incorrect Proxy Settings 

Find out the details of and configure your proxy server settings as described in Section 3.4. Consult 

your local systems administrator if the problem persists.  

Network down 

Try the software again later. Consult your local systems administrator and contact 

ausrivas@canberra.edu.au if the problem persists. 

mailto:ausrivas@canberra.edu.au
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6.1.2 Proxy authentication required 

Symptoms 

When attempting to run AUSRIVAS v2.2 or below, an error message similar to one of the following is 

generated:  

- HTTP error 407: Proxy authentication required  

Description of problem 

AUSRIVAS Version 2.2 and below 

AUSRIVAS 2.2 and below does not support proxy authentication. If your proxy server requires 

authentication (i.e. you have to provide a username and password to access the Internet) then you 

will need to upgrade to version 3.0 or above. 

AUSRIVAS Version 3.0 and above 

Your proxy authentication settings in AUSRIVAS are possibly not correct.  

Solution 

AUSRIVAS Version 2.2 and below 

Upgrade the AUSRIVAS Macroinvertebrate Predictive Modelling Software to version 3.0 or above, as 

described in Chapter 3. 

AUSRIVAS Version 3.0 and above 

Following the procedure outlined in Section 3.4 make sure that your proxy server settings and your 

Internet username and password are correct. Consult your local systems administrator if the 

problem persists.   

6.2 Errors or warnings in your input data 

Errors and Warnings in your input data are discussed in earlier chapters in this manual. Refer to the 

Sections below to find information on the error/warning you are interested in. 

6.2.1 Warnings 

Warning Refer to 

Missing Taxa Section 3.6.1 

Taxon name and signal score not known in AUSRIVAS  

 

Section 3.3.3 

Site is nearly outside the experience of the model  
(Chi2 0.01) 

Section 3.6.2 and Chapter 7 
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6.2.2 Errors 

Warning Refer to 

Missing predictor variable Section 3.6.1 

Site Mismatch Section 3.6.1 

Blank data cells Section 3.6.1 

Not a valid phys/chem code  

 

Section 3.3.3 

Site is outside the experience of the model (Chi2 0.001) Section 3.6.2 and Chapter 7 

 

6.3 Errors in your outputs 

6.3.1 Site is nearly outside the experience of the model 

 
 

 

For information on this warning, refer to Section 3.6.2 and Chapter 7. 

6.3.2 Site is outside the experience of the model 

 

For information on this warning, refer to Section 3.6.2 and Chapter7. 

6.3.3 Site is unexpectedly outside the experience of the model 

If your site is unexpectedly outside the experience of the model, check the Phys/Chem input data for 

errors, such as: 

- Typographic errors;  

- Incorrect units of measurement used for predictor variables;  

- Incorrect format used for LATITUDE or LONGITUDE predictor variables.  

6.3.4 Extra output or incorrect colour coding of output 

Each time a model is run the existing data in the spreadsheet should be cleared to ensure that this 

data does not remain when new data are run through the model. There are several ways to clear 

data: 

1. Select the entire spreadsheet by clicking in the top left corner of the spreadsheet and 

then select 'Clear' from the 'Edit' menu.  

2. Click on the new icon  in the toolbar.  

3. Select 'New' from the 'File' menu.  

 



AUSRIVAS Software User Manual 

   Page 45 of 46 

CHAPTER 7. WHAT IS THE CHI2 TEST?  

7.1 What is the Chi2 test? 

The Chi2 test is used to determine if a test site falls within the experience of the AUSRIVAS model. 

Any test sites with no appropriate reference group for comparison are identified as being 'outside 

the experience of the model'.  

AUSRIVAS determines that a site is 'outside the experience of the model' if its critical value is within 

the 0.1 percent area (alpha = 0.001) in the tail of the Chi2 distribution. In the case of a site being 

outside the model’s experience, the site is colour coded in red, the error message detailed below is 

shown and no output is produced for that site (shown below).  

  

AUSRIVAS also determines when a site is ‘nearly outside the experience of the model’. In this case, 

the critical value falls within the 1 percent area (alpha = 0.01) in the tail of the Chi2 distribution. If a 

site is ‘nearly outside the experience of the model’ as determined by the above test, the site is 

colour coded in orange and a warning message is given (shown below). In this case, output data for 

the site are still produced but should be interpreted with caution.   

  

7.1.1 Is the site unexpectedly outside the experience of the model?  

If your site is unexpectedly outside the experience of the model, check the 'Phys/Chem' input data 

for errors, such as:  

- typographic errors, 

- incorrect units of measurement used for predictor variables, or 

- incorrect format used for LATITUDE or LONGITUDE predictor variables. 

7.1.2 Further information 

For further information see: 

Clarke, R.T., Furse, M.T., Wright, J.F. and Moss, D. (1996). Derivation of a biological quality index for 

river sites: comparison of the observed with the expected fauna. Journal of Applied Statistics 23, 311-

332. 
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CHAPTER 8. HELP 

For all questions and help with the following subjects please contact: ausrivas@canberra.edu.au  

- Software or technical problems 

- Errors running the model 

- Construction of a new model 

- For information on coverage of models - https://ausrivas.ewater.org.au/index.php/models  

- Manuals - https://ausrivas.ewater.org.au/index.php/manuals-a-datasheets  

- Problems with your password 
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